Advanced Sponsored Projects Reporting Guide

Advanced Options - Project Definition Overview List (ZFR1AM)

Overview of the Project Definition Overview List

The Project Info System: Project Overview (List of Projects) is a transaction used to display a list of Projects by different selection criteria. This report has a selection screen variant named Projectlist that has already been created to help you select your list of projects. This variant displays additional recommended selection fields such as BFR Code / Org. Unit, Parent, Responsible Person (Primary Principal Investigator’s Duke Unique ID), and Grant Administrator (Duke Unique ID of the person designated by Department Administrator to be the Grant Administrator in the department). In addition the list can be used to select by any of the master data fields associated with the project, such as SPS number, Project Begin or End Date, etc.

The list includes all released projects (with a status of REL) for the selection criteria chosen. In addition, the list can be run for all closed projects and sorted by date as covered in this advanced guide.

Review: Accessing the List and Selecting the Basic Criteria

Note: For more details, refer to the University Reporting: Sponsored Projects Guide at the following URL: http://www.r3.duke.edu/training/stepbystep/index.php#usp

1. Access via menu path: Financials → Financial Master Data → Project Info System: Project Definition Overview

Note: If preferred, use Transaction code ZFR1AM (versus the actual transaction code listed on the User Menu).

2. If prompted, enter 1 in the PS Info Profile field and click OK to close the Information dialog box).
To get the standard selection screen variant:

Note: A selection screen variant saves keystrokes by adding dynamic selections and / or populating fields with values. Variants may be created by central areas for use by all or by individual users for personal use or for use by the department, division, etc. **Never save over / overwrite a standard layout used by all.**

3. Click on the [Get Variant](Shift+F5) button to display the **Find Variant** dialog box (shown below).

4. **Delete your User ID** (the default) from the **Created by** field (or leave your User ID if you have created your own variant).

5. Enter the value of **PROJECTLIST** in the Variant field or choose your own variants you may have created as follow.

   Note: To see all variants available, leave the Variant field blank and click on the [Execute](Execute) button. **Double click** on a variant name to select.

6. Click on the [Execute](Execute) button to return to the **Project Info System: Project Definitions Initial Screen** (shown below).
Advanced Options - Project List (cont.)

7. Once the PROJECTLIST variant is selected, note that the **Dynamic Selections** button includes “1 active” and the **Project** fields contain a range of Project numbers (2000000 – 3999999).

   **Note:** This variant only includes Projects with a status of REL (released) and for Company Code 0010. **If needed, adjust the range to end with 3899999 to include only federally sponsored projects.**

8. Click on the **1 active (Dynamic selections)** button to display more selection options at the **top** of the screen (see next page).
9. Note the **0010** value already entered in the **Company Code** field – **do not delete this value**.

10. Use the fields now displayed on the right to enter values and select the list of projects by Person Responsible (DUID), BFR Code (Org. Unit), Parent, and /or Grant Administrator ID (DUID).

   **Note:** The PROJECTLIST variant displays recommended selection fields on the right side for your convenience. There are many fields on the left that may also be selected and used on the right side to select criteria per the next steps of this advanced guide.

11. Note that when entering a higher level BFR Code / Org. Unit in the field, use an * (asterisk) at the end of the code to replace any zeros (can’t use the full code if higher level ends in zeros).

12. Use the steps on the next pages to find other available Sponsored Project fields for selection in folders on the upper left and add those fields to the upper right side as additional selection criteria BEFORE executing the report.
Using the Projectlist Variant to Select the List by Other Available Spon. Proj. Fields

1. Use the steps in the Review section to get the Projectlist variant and click on the Dynamic Selections button.

2. On the left side, scroll down to the Spon. Proj. Fields folder (next to last folder listed that contains most of the selection fields you might like to use).

3. Click on the Twister button to open the desired folders and find master data folder (may also find some master data values in the Master Data Definition folder as well, like Description field for WBS Element/Projects and Applicant number to select a list of projects for a specific Sponsor).

4. Scroll through all the available input fields listed in the Spon. Proj. Fields folder (or other folders) on the left side that may be used as selection criteria to generate a list of projects.

   - The fields displayed in the folders are master data for the project found in the Project / Work Breakdown Structure (Transaction Code CJ03) including Customer Fields.

   - The fields highlighted in green have already been selected and displayed as input fields on the right side of the screen (some were selected when the PROJECTLIST variant was used earlier).
5. To choose a selection field in the Spons.Proj. Fields folder or other folders and display it on the right side, locate the field and simply **double click on the field name**—see chart below for suggestions and entry tips, and remember to use these fields along with BFR Code or Grant Manager ID for optimal results:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
</table>
| SPS Number        | Use this field to select a list of projects for a specific SPS Number (number assigned to proposals and awarded grants in the Sponsored Projects System), for example to find newer projects by using a newer SPS numbers with a wildcard selection. The value in the field must be right justified and the easiest way to enter the value is outlined below:  
  - Enter a six digit value for new SPS numbers in the SPS No field, e.g. 230000 (newer SPS number range in 2017).  
  - Click the **Enter** button to right justify the value in the field.  
  - Ensure the OVR (Overwrite) option is displayed in the lower right on the bottom bar of SAP (click on the value or use the Insert key to toggle between Insert and Overwrite as needed).  
  - Enter a wildcard * (asterisk) to replace the 0 digits, example 23*.  
  - Continue selecting other fields as needed and generate the report                                                                                                                     |
| Project End Date  | Use to select a list of projects that end on a certain date (use the field’s **Multiple Selections** button to choose multiple dates or ranges).                                                                                                                                                                            |
| PI #2 Number      | Use to select a list of projects by the Co-Principal Investigator’s Duke Unique ID (use **Drop Down** button to search and find if needed).                                                                                                                                                                                                                     |
| Dept. Project Name| Use to select a list of project by the project name that is assigned by the department for reference                                                                                                                                                                                                                                                  |
Advanced Options - Project List (cont.)

<table>
<thead>
<tr>
<th>CC Backstop or WBS Backstop</th>
<th>Use to enter a CC Backstop cost object (7 digit cost center) or a WBS Backstop cost object (7 digit WBS element) to select a list of all the projects tied to that funding source for cost overruns or any late activity that is transferred during closeout.</th>
</tr>
</thead>
</table>
| Description | Available in the **Master Data Definition** folder – use to select a list of projects based on some part of the description text along with or enclosed in wildcards * (asterisks). A couple of examples are outlined below:  
  - To select a list all projects related to an agency (good to find all 7 digit WBS Elements associated with one grant that roll over across years to new cost objects as required by a Sponsor), enter the 6 digit agency code enclosed in asterisks, example *100645*. This 6 digit agency code is found within the Federal Prime Grant Number, as in this example of 5UM1-AI100645-04.  
  - To select all the WBS Elements designated as a Parent Code or Composite Code within a BFR or for a Grant Manager ID, enter the value of *PAR* or *COMP* in the Description field. |
| Applicant name or Applicant (number) | Available in the **Master Data Definition** folder, use to select a list of projects for a Sponsor (use the **Drop Down** button to search if needed). |

6. Once additional fields are selected and displayed on the right side, **use vertical scroll bar on right side to see newly added fields**

7. **Enter the desired values** in any of the input fields including the use of wildcards * (asterisks) as needed – see chart above for suggestions and tips on entering values and use of wildcards.
Advanced Options - Project List (cont.)

8. **OPTIONAL:** Use the **Save as Variant** button to save this selection screen as a new variant, if desired - **DO NOT SAVE OVER PROJECTLIST – SEE NEXT PAGES.**

9. Once all criteria is selected (including the range 2000000 – 3999999 populated in the Project fields by the Projectlist variant), click the **Execute** button to generate the list.
Saving and Using Your Own Selection Screen Variant for Future Use

**Note:** A selection screen variant saves keystrokes by adding dynamic selections and/or populating fields with values. Variants may be created by central areas for use by all or by individual users for personal use or for use by the department, division, etc. **Never save over/overwrite a standard layout like Projectlist that used by all.**

1. Use the steps previously outlined to get the Projectlist variant, add more selection criteria fields to the right side, and enter any values that you would like to save as part of a variant (may populate some fields and leave others blank as needed).

2. Before executing the report, click on the **Save as Variant** button.

3. Click on the **Yes** button to save both the parameters and the settings.
4. In the Variant Name field, **delete the value Projectlist and** **ENTER A NEW NAME (DO NOT SAVE OVER THE PROJECTLIST VARIANT).**

5. Enter a new description in the Meaning field to help you identify the selection screen variant.

6. Click the **Save** button at the top of the screen to save the new variant and exit the Variant Attributes screen.
Advanced Options - Project List (cont.)

To get the selection screen variant and use it later:

7. Access the Project Info System: Project Definition Overview selection screen (do not get the Projectlist variant if you are using your own variant that you created in earlier steps).

8. Click on the Get Variant button.

9. In the resulting Find Variant box, to find your own variant or variants, ensure your Net ID is displayed in the Created by field (if not, enter your Net ID).
10. Once the Created by field contains your Net ID, click on the **Execute** button and note the results as outlined below:

- **If you have only one variant** created for this selection screen, the values saved in that variant will automatically populate the fields.

- **If you have more than one variant** for this selection screen (as shown in example above), in the resulting list, **double click** on the variant name to populate the fields with the values saved in that variant.

11. Once all criteria is entered or updated, ensure the project range is listed in the Project fields and click the **Execute** button to generate the list.
Changing the Layout of the Project List Once Displayed

1. Once the Project List results are displayed (report is executed), change the layout (the look) of the report per the next steps.

2. Click on the Choose fields… button or follow the menu path: View → Choose fields…

3. In the Select fields window:
   - Note that the columns already displayed in the project list are shown under Selected Fields on the left side in the order that they currently appear on the project list report.
   - Use the fields listed on the right side to find and add columns to the report (listed alphabetically by column name or use search) per the next steps.
4. Using the right side of the screen, locate a column to be added to the report (sorted alphabetically; use the Find button to locate the field as needed, e.g., enter Proje* in the search field to easily find for Project End date).

5. To select the column to be added, click once on the box to the left of the column field name on the right side (multiple columns may be selected by using the Ctrl key).

6. Optional: To select where the column(s) should be added/inserted, click on the desired column name under the Selected Fields section (left side) to indicate that you want the new column to be inserted above this column.

7. Click on the Choose button to add the selected column(s) on the right side into the Selected Fields section on the left side (note that if the optional step above is not done, the columns will be added to the end of the list by default).
8. Review the columns now added to the left side under Selected Fields (in this example, PI # 2 Name and Parent).

9. To move the order of any columns listed on the left side under Selected Fields section:
   - First, click on box to the left of the column to be moved.
   - To move the column up the list, click on the box for the column that the moved column should fall AFTER in the list.
   - To move the column down the list, click on the box for the column that the moved column should fall BEFORE in the list.
   - Click on the Move button,
   - Review the results and adjust as needed.
10. To remove columns that are already displayed under Selected Fields (thus removing the column from the Project List):
   - Click on the box to the left of the column
   - Use the Do not choose button.

11. When all columns are selected and in the desired order on the left side under the Selected Fields section, click on the Continue button to complete the process.

12. Review the new columns now displayed for your list and the order of the columns, and adjust as needed.

Note: The layout cannot be saved for future use like in other SAP financial reports. Repeat the steps above each time you access the report to add the columns you’d like. Do NOT save an Overview when exiting as this feature does not allow you to easily change selection criteria in the future.
Advanced Options - Project List (cont.)

Sorting the List by Project End Date to Identify Projects to be Closed

1. Once the Project List results are displayed (report is executed), follow the steps below to sort the list by the Project End Date and review for any projects that should be closed (end date is in the past).

2. Use the previous steps to change the layout (View → Choose fields) to add the Project End Date column (place column beside the Finish Date column to help with the review).

3. Click once on the newly added Project End Date column heading to select that column.

4. Click on the Sort Ascending button to sort the column so that the oldest dates sort to the top of the report.
Advanced Sponsored Projects Reporting Guide

Advanced Options - Project List (cont.)

5. Review any end dates that are in the past and take appropriate action to resolve the issues so that the project will close.

6. To reset the report, exit the report completely (choose NO to saving the Overview) and select criteria and execute again.
Advanced Sponsored Projects Reporting Guide

Advanced Options - Project List (cont.)

Exporting the Project List to Excel

1. Click on the [Export] button.

2. In the [Export] box, click on the [Spreadsheet XXL] button.

3. In the [Export List Object to XXL] box, click on the [Table] radio button; click on the [Continue] button to proceed.

4. In the next [Export List Object to XXL] box, ensure the [Microsoft Excel] radio button is selected; click on the [Continue] button.
Exiting the Project List Reminder

1. Click on the Back button to exit the report and display the Exit Information System dialog box.

2. Click on the No button (Do NOT save Overview) to exit the line item view and return to the Project Info System: Project Definitions Initial Screen.

3. Click on the Exit button (Shift+F3) until the initial R/3 screen is displayed.